
OVERVIEW

MetaShoot™ is a digital twin of a photo studio, developed as a plugin for Unreal Engine that gives any creator the ability to 
produce highly realistic renders in the easiest and quickest way.

It includes lighting presets, a simplified render interface, 360 camera, and 14 different interactive assets to create your 
own virtual photo studio.

MetaShoot™ brings Product Visualization rendering - a $30M+ industry - to a real-time platform thanks to Unreal Engine.
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INSTALLATION & SETUP

1 - Purchase MetaShoot from Unreal Engine’s Marketplace.

2 - Open EPIC Game’s Launcher, go to the Library tab and find MetaShoot under Vault and click “Install to Engine”.

3 - Open an existing project or create a new one. In order for MetaShoot to work optimally RayTracing needs to be active.

4 - Make sure MetaShoot is active in the project, otherwise enable it from Edit/Plugins:

5 - Additionally to MetaShoot you need to enable both “Movie Render Queue” and “Movie Render Queue Additional Render 
Passes”
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6 - Now that MetaShoot and the necessary plugins are enabled, open MetaShoot from the Window tab:
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6* - If any of the necessary plugins from point 5 is not enabled MetaShoot will show this when open: 

7 - If everyting was installed correctly this window will appear:
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8 - It’s a good time now to dock the MetaShoot window in your UE viewport.
We recommend placing it next to the Place Actors tab:

9 - If you want to start your first photo studio, create a new empty level in your Content Broswer and simply drag the 
“Studio” asset from MetaShoot into the scene. Selecting any preset will also spawn a full studio if there aren’t any currently 

in the scene.

9* - If the viewport camera hasn’t been moved since creating the Level, the scene will look like the image above. Move the 
camera as you would in any project to reveal the full studio.
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10 - Everything is ready! You can now import your own models and place them in the studio.

Next we will go over the 3 different tabs in the MetaShoot menu
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Assets Presets Render
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METASHOOT INTERFACE: ASSETS TAB
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1 - Studio: Empty actor that contains the rest of assets. It is responsible for organising the presets and interacting with the 
MetaShoot render interface. It is recommended to always have one Studio actor as the parent of the other assets.

2 - Cyclorama: Info on page 09

3 - Rail System: Info on page 10

4 - Turntable: Info on page 11

5 - DSLR Camera: Info on page 12

6 - 360 Camera: Info on page 13

7 - Target: Info on page 14

8 - Overhead Lightbank: Info on page 15

9 - Softboxes: Info on page 16

10 - Other Lights: Info on page 17

To add any of the assets to your scene, drag and drop them from the menu to the viewport.
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METASHOOT INTERFACE: PRESETS TAB
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1

2

1 - Preset scenes: 8 fully prepared photo studios with different lightings and backgrounds. Click to apply. If no MetaShoot 
Studio actor is in the scene, it creates a new one with everything inside. If more than one MetaShoot Studio actor is in the 

scene, it applies to the closest one to the viewport camera.

2 - Update: These checkboxes define which elements from the presets are going to be applied. If there is an existing 
MetaShoot Studio in the scene, only the checked elements will be replaced by the ones from the preset.

Example case #01:
“I have a scene with my 3D model and a MetaShoot camera already prepared, and I don’t want to modify the background 

but I want to try different lightings”

Example case #02:
“I only have my model in the scene with the turntable and I want to try different studio setups”

It is very important to uncheck the elements that you don’t want to change before selecting a preset, otherwise the 
previous elements in the scene will be replaced by the default ones in the preset.

I.e. the camera and target that you have already prepared
or the turntable that you have already set up.
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METASHOOT INTERFACE: RENDER TAB 1/2
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1 - RENDER: This button will start the rendering process with the settings specified below. It needs to have a MetaShoot 
DSLR Camera selected in the viewport, or alternatively a MetaShoot Studio actor with a DSLR Camera inside. Note that 

launching the rendering process with a MetaShoot Studio actor selected will render ALL the DSLR Cameras inside it in a 
row, effectively creating a render queue.

2 - Render Project Title: This field drives the output folder where the renders will be stored. The output directory will be 
location of the project + /Saved/MovieRenders/ + this project title.

3 - Resolution: Controls the size of the rendered image. When Lock ratio is checked, both numbers will scale proportionally 
when one of them is changed.

4 - Duration | Frames: Number of frames that will be rendered.

5 - Get from turntable: Gets the duration of the turntable selected and calculates the total number of frames needed 
following the specified frame rate.

6 - Frame rate: Number of frames that fit in one second.

7 - Quality: Modifies the render settings to produce a cleaner but slower image, or a faster but less detailed and more 
grainy image.

8 - Renderer: Controls which renderer will be used, the Base / Deferred renderer and/or the Path Tracer. If both are 
checked, the output will have 2 different images per frame.

9 - Denoiser: When checked, applies a denoiser filter to the rendered image. When unchecked, it leaves the raw rendered 
image which depending on the Quality will be more or less noisy/grainy.

10 - Motion Blur: When checked, motion blur will be applied to the render if the models are animated or the turntable is 
rotating. When unchecked it will render a clean image without motion blur even if the model is animated.

*Continues in the next page
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METASHOOT INTERFACE: RENDER TAB 2/2
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11 - Update All Lights: It forces all the MetaShoot lights to refresh - useful when scissors and tripods are buggy.

12 - Fix Depth of Field: It runs the command “r.TemporalAA.Upsampling 0” to improve DOF. Thanks to William Faucher.

13 - Fix Path-Traced Instances: It makes instanced meshes visible in the Path Tracer.

14 Fix Texture Streaming Pool: Increases the amount of storage dedicated to texture streaming.
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CYCLORAMA

Settings

Background for the photo studio. The color can be modified, and separated into two: one for the floor and back and a 
different one for the sides. The width is also adjustable, without deforming the model. It also allows to quickly modify the 

Reflection and Roughness of the material, and add Fog with a simple click on the checkbox.

Width: Controls the width of the cyclorama. The 3D models has been built in a modular way so it doesn’t deform.
Center Color: Controls the color of the background and floor. 
Sides Color: If Single Color is unchecked, it controls the color of the sides of the cyclorama.
Single Color: When checked, all the cyclorama will pick the Center Color. When unchecked, the sides will pick the Sides 
Color. 
Unlit: When checked, light won’t affect the cyclorama, getting a totally flat-looking background.
Reflection: Controls the reflection of its material.
Roughness: Controls the roughnes of its material.
Fog: When checked, it adds atmospheric fog to the scene.
Fog Density: When Fog is checked, it controls the density of the atmospheric fog.
XOffset: Controls the position on the X axis of the cyclorama relative to its origin.
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RAIL SYSTEM
It offers a support to any softobx or MetaShoot&#8482; light underneath. The rails automatically update to follow any light 

below. One rail can fit up to 2 lights - the rail adjust its rotation so both lights fit in it. Both separation of the beams and 
total length can be adjusted.

Beam Separation: Controls the length of the gap between the two wooden beams.
Beam Length: Controls the total length of the beams.
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Sett ings
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TURNTABLE
A fully prepared turntable for meshes and actors. Any asset selected to be inside it will rotate when playing and rendering. 

It allows to adjust the total rotation and the duration of it, as well as the direction of the rotation. It also offers a Loop 
option for infinite rotation. The base can be hidden or shown in the final render (hidden by default). Meshes can be directly 

spawned from its interface and adjusted via its Transform menu.

Rotate: When checked, it activates the rotation of the turntable. When unchecked the turntable won’t rotate.
Rotation Total (degrees): The final angle in degrees that the turntable will reach in one cycle. 
Rotation Duration (s): The duration in seconds that it will take for the turntable to reach its final angle.
Delay Start (s): Time that it will take for the turntable to start rotating. 
Loop: When checked, the turntable will go back to its original rotation after reaching the final angle and will start again. 
When the Rotation Total is 360, the Loop option will create a seamless continuous rotation.
Clockwise: When checked, the turntable will rotate clockwise. When unchecked, the turntable will rotate counter-clockwise.
Actor: Picking an actor will make it a child of the Turntable in the hierarchy so it rotates with it.
Mesh: Spawns a mesh that will rotate with the actor.
Material: Controls the material of the spawned Mesh.
Mesh Transform: Controls the transform of the spawned Mesh.
Base Scale: Scale of the turntable’s visible base.
Base Hidden in Render: When checked, the turntable’s base will be hidden in the render. When unchecked the turntable’s 
base will appear in the render.
Preview Rotation Axis: When checked, it shows with a blue line the axis that the turntable rotates around.
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Sett ings
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DSLR CAMERA

Sett ings

A camera prepared to work with the MetaShoot™ Render System. It offers a simple target system that updates both the 
focus and the tracking settings of the camera. The camera is hidden in the render by default, but can be shown if needed. 

Clicking Render will render the currently selected camera.

DSLR Mesh Hidden in Render: When checked, the camera’s mesh will be hidden in the render. When unchecked the 
camera’s mesh will appear in the render.
DSLR Mesh Scale: Controls the scale of the camera’s mesh. 
Target: It assigns an actor to both the Focus Settings and the Tracking Settings.
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360 CAMERA

Sett ings

A camera that creates an equirectangular-360-degree render of the scene, with a 2:1 ratio, independent of the ratio 
specified in the Render Settings - it only takes the first value (x) of the Render Resolution and halves it for the y value. It 

allows to create HDRIs to use in other rendering software such as Maya, Blender, Cinema 4D, etc.

360 Camera Mesh Hidden in Render: When checked, the camera’s mesh will be hidden in the render. When unchecked the 
camera’s mesh will appear in the render.
360 Camera Mesh Scale: Controls the scale of the camera’s mesh. 
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TARGET

Sett ings

All the MetaShoot™ lights and cameras linked to this actor will update its rotation in real-time when it moves. It offers an 
easier way of adjusting the model position without losing the focus of the lighting. When the target is animated it will also 

make the lights and cameras follow it in the render.

Move to Actor: It will move the target’s location to the origin of the selected actor.
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OVERHEAD LIGHTBANK

Sett ings

A big light panel intended to provide top-down lighting, although it can also be placed in any other way. It allows to adjust 
the intensity, temperature and tint. With the intensity

Intensity - Candelas: Controls the intensity of the light.
Temperature: Controls the temperature in Kelvin degrees of the light - lower temperature gives warmer values, higher 
temperature gives colder values. 6500K equals white light. 
Use Temperature: When checked, the light will add the Temperature value to the light’s colour.
Tint: Adds a colour to the light.

DOCUMENTATION    |    15https://metashoot.vinzi.xyz



SOFTBOX

Sett ings

All the MetaShoot™ lights have been developed to act as close as possible to real studio lights, not only when it's turned on 
but also when it's off, with a realistic diffuser. The diffuser can be removed to expose the light bulb and have a direct 

hard-shadow light. A grid can also be added to all softboxes to make the light more directional. When the light is close to 
the ground a tripod appears, which updates automatically following the light position and rotation. If the light is closer to a 

ceiling or the Rail System, the tripod gets swapped by a scissor system, which also updates in real time. The number of 
segments of the scissors is customizable.

Light Type: Selects the type of softbox/light. The softbox options are 60x60, 50x70, 30x120, 70x70 Octogonal. Other light 
options are Light Wand, Spot Light and Ring Light.
Intensity - Candelas: Controls the intensity of the light.
Temperature: Controls the temperature in Kelvin degrees of the light - lower temperature gives warmer values, higher 
temperature gives colder values. 6500K equals white light.
Uste Temperature: When checked, the light will add the Temperature value to the light’s colour.
Tint: Adds a colour to the light.
Diffuser: When checked, the diffuser of the light will be on. When unchecked, the diffuser will be removed, showing the 
inside of the softbox and its light bulb. Removing it provides a hard shadow.
Grid: Adds a grid to the diffuser which makes the light more directional.
Support: Selects the type of support for the light: Tripod (ground support), Scissors (ceiling support), or None. Automatic 
mode detects what’s closer to the light and applies the right type of support.
Scissors Segments: Controls the number of segments that the scissors have.
Actor to Track: When an actor is assigned, the light will always look at its origin. It is recommended to use a MetaShoot 
Target as the actor to track since it has been programmed to update in real time.
Rotation: When the light is tracking an actor, it controls the extra rotation around its axis.
Branding: When checked, it shows the MetaShoot branding on the light. When unchecked, it will have no branding.
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OTHER LIGHTS

Sett ings

All the MetaShoot™ lights have been developed to act as close as possible to real studio lights, not only when it's turned on 
but also when it's off, with a realistic diffuser. The diffuser can be removed to expose the light bulb and have a direct 

hard-shadow light. A grid can also be added to all softboxes to make the light more directional. When the light is close to 
the ground a tripod appears, which updates automatically following the light position and rotation. If the light is closer to a 

ceiling or the Rail System, the tripod gets swapped by a scissor system, which also updates in real time. The number of 
segments of the scissors is customizable.

Light Type: Selects the type of softbox/light. The other light options are Light Wand, Spot Light and Ring Light. Softboxes 
can also be selected from this menu. These are 60x60, 50x70, 30x120, 70x70 Octogonal.
Intensity - Candelas: Controls the intensity of the light.
Temperature: Controls the temperature in Kelvin degrees of the light - lower temperature gives warmer values, higher 
temperature gives colder values. 6500K equals white light.
Uste Temperature: When checked, the light will add the Temperature value to the light’s colour.
Tint: Adds a colour to the light.
Support: Selects the type of support for the light: Tripod (ground support), Scissors (ceiling support), or None. Automatic 
mode detects what’s closer to the light and applies the right type of support.
Scissors Segments: Controls the number of segments that the scissors have.
Actor to Track: When an actor is assigned, the light will always look at its origin. It is recommended to use a MetaShoot 
Target as the actor to track since it has been programmed to update in real time.
Rotation: When the light is tracking an actor, it controls the extra rotation around its axis.
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MetaShoot includes its presets to be used in the normal Movie Render Queue workflow without the need of the MetaShoot 
render interface. To access them, got to Movie Render Queue, click on the Settings column which usually says “Unsaved 

Config*”, and then “Load/Save Preset”. The 8 MetaShoot presets should appear on the list. They match the settings of the 
4 levels of Quality in the Render interface, with and without Denoiser.

RENDER SETTINGS PRESETS
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SHOWCASE
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MetaShoot Ultra High Quality Render settings + 1536 Total Samples + Path Tracer - No Denoiser

MetaShoot Ultra High Quality Render settings + Path Tracer - No Denoiser
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SHOWCASE
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MetaShoot Ultra High Quality Render settings + Path Tracer - No Denoiser

MetaShoot Ultra High Quality Render settings + Path Tracer - No Denoiser
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FAQ & TROUBLESHOOTING

Issue: The MetaShoot lights are floating without tripod or scissors when opening the project.
-Go to the MetaShoot window and click on any tab (Assets, Presets or Render). This will solve it.

Alternatively, inside the Render tab, there is a button called “Update All Lights” which should solve it as well.

Issue: Using Path Tracer I can’t see the scissors of the MetaShoot lights.
-Inside the Render tab click on “Fix Path-Traced Instances”

For more troubleshooting and to post your own questions, find the link to our Discord support channel in the website:
https://metashoot.vinzi.xyz
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ABOUT & CONTACT

MetaShoot™ has been created and fully developed by Valle (Jorge Valle Hurtado), including all 3D modelling, texturing, 
programming in C++ and Blueprints, trailer animation, concept, design, branding, website development using vanilla HTML, 

CSS and JavaScript, copywriting and marketing material.

Valle is the founder of VINZI and Senior 3D Engineer & Technical Lead at Futureverse - Non Fungible Labs.
Previously Build Lead and 3D Industrial Designer at Wētā Workshop where he worked on projects like "Avatar: The Way of 

Water" and "The Lord of the Rings' The Rings of Power".
He also participated in Dubai's World Expo 2020 as a mechanical an industrial design engineer and is the co-creator of 

Adobe's Virtual Gallery.

Auckland, New Zealand

Contact: valle@vinzi.xyz
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